Ocean Optics & Biogeochemistry Protocols for Satellite Ocean Colour Sensor Validation

Volume 8: Dissolved Organic Matter Sampling and Measurement Protocols: Consensus Towards Future Ocean Color Missions (V1.0)

Authors:
Chelsea N. Lopez, Antonio Mannino, Michael Novak, Lillian Custals ...

International Ocean Colour Coordinating Group (IOCCG) in collaboration with National Aeronautics and Space Administration (NASA)

IOCCG, Dartmouth, Canada
# TABLE OF CONTENTS

1 INTRODUCTION & BACKGROUND .................................................................4

2 HISTORY ........................................................................................................5

   2.1 General Early History ........................................................................... 5

   2.2 Wet Chemical Oxidation (WCO) ......................................................... 6

   2.3 High Intensity UV Radiation ............................................................... 6

   2.4 High Temperature Combustion (HTC) .................................................. 7

   2.5 A Comparison of Analytical Methods .................................................. 7

   2.6 The Development of the Certified Reference Material (CRM) Program .... 8

3 SAMPLE COLLECTION PREPARATION .......................................................8

   3.1 Vials ........................................................................................................ 8

   3.2 Hydrochloric Acid ................................................................................ 8

   3.3 Filters, Filter Cartridges, and Filter Capsules ....................................... 9

4 SAMPLE COLLECTION & STORAGE .........................................................10

   4.1 Sampling Preparation .......................................................................... 11

   4.2 Inline Niskin Sampling ....................................................................... 11

   4.3 Surface Sampling ................................................................................ 13

   4.4 Benchtop Filtration ............................................................................. 14

   4.5 Post-Collection Processing ................................................................ 15

      4.5.1 Acidification ................................................................................ 15

      4.5.2 Freezing ....................................................................................... 17

   4.6 Notes on Sampling at Sea .................................................................... 17

5 HIGH TEMPERATURE CATALYTIC COMBUSTION THEORY ..............18

6 PREPARING STANDARDS ..........................................................................22

   6.1 Manual Stock Dilutions ...................................................................... 23

      6.1.1 Preparation of Stock Solution ....................................................... 23

      6.1.2 Dilution of the Stock Solution ....................................................... 25

   6.3 Reference Material ............................................................................. 26

7 PREPARING FOR INSTRUMENT MEASUREMENT ................................26

   7.1 Removing the Column from the Instrument ......................................... 26
1 INTRODUCTION & BACKGROUND

Marine organic carbon is crucial to global biogeochemical cycling, therefore understanding its complex dynamics is essential as the world around us changes. The largest reservoir of organic carbon in the ocean exists as dissolved organic carbon (DOC) (~662 PgC, reported in 2009) and is comparable in magnitude to the stock of carbon in the atmospheric CO$_2$ pool, which is ~800 PgC as of 2020 (Hansell, 2009; 2013; climate.gov).

Marine DOC originates from the production and release of organic compounds by marine phytoplankton during photosynthesis. The term “DOC” is quite broad, including sugars, amino acids, fatty acids, and other complex organic molecules smaller than 0.2 µm in size (Hansell and Carlson, 2015) that are difficult to quantify. The bacterial and enzymatic degradation of complex organic matter, such as deceased phytoplankton, zooplankton excretions, and fecal material, contribute to the release of DOC in the ocean. In coastal and estuarine areas, decaying plant and animal matter, soil erosion, groundwater flow, and discharge from rivers contribute to the DOC pool.

In the euphotic and mesopelagic water column, DOC measurements provide important insight into the dynamics of modern processes, such as primary production and bacterial respiration rates. In the bathypelagic, enhanced DOC concentrations can provide evidence for large-scale particle export. The dynamics of the DOC pool is tightly coupled with other carbon reservoirs through chemical, physical, and biological exchanges. From a wider scope, large fluctuations in the stock of DOC are speculated to be consequences of major changes in global biogeochemical cycling on geological timescales (Ridgwell and Arndt, 2015). Given the current rapid changes in climate and carbon cycling, a robust understanding of the composition, global distribution, and overall dynamics of the DOC pool is crucial.

In the age of ocean color satellites, quantification of DOC from its relationships between chromophoric dissolved organic matter (CDOM) is being explored (Aurin et al., 2018; Bonelli et al. 2022; Mannino et al., 2016; Cao et al., 2018; see review by Fichot et al. 2023). However, such direct connections between satellite-derived CDOM measurements and DOC are highly variable.
and region-dependent, requiring more work to establish reliable algorithms that describe the global ocean. As such, a continuation of dependable DOC sample collection and instrumental analysis is imperative for future satellite validation work.

We must strive for universally accurate and consistent measurements of oceanic and coastal DOC. The methods for both sample collection and instrumental analysis of DOC have evolved significantly over time, ranging from photo- and chemical-oxidation methods that date back to the 1960’s (Armstrong et al., 1966) to the current high temperature catalytic oxidation (HTCO) methods. The development of HTCO better resolves biogeochemical mass-balance disagreements that were problematic with older analytical methods and therefore is now widely used. However, disparities in sample collection, storage, and final data processing still exist across laboratories.

Given the current inconsistencies of methodology and the modern advancement of ship-board capabilities and instrumentation, we suggest this protocol in hopes that it is adopted by the scientific community to achieve universal consistency. This protocol details all steps necessary for high-quality DOC measurements, from at-sea sample collection to offline data processing. We also include a walkthrough of key chemical processes and their relation to individual components of the HTCO instrumentation often used for DOC measurement. With this, we aim to provide a foundational understanding of the instrumentation to better troubleshoot when problems inevitably arise.

2 HISTORY

2.1 General Early History
The DOC measurement has a long history, as the first published method was in 1892 by Austrian scientist Dr. Konrad Natterer (Natterer, 1892; Sharp, 1997), who simply measured weight after alcohol extraction of salts derived from evaporated seawater. A new method evolved 17 years later; reduction via permanganate (Putter, 1909) that was proceeded by a chromate acid oxidation method in 1910 (Raben, 1910). These oxidation-based methods were called “wet chemical oxidation” (WCO). Many variations of the wet chemical oxidation methods were developed over
the decades, but they were superseded by high temperature combustion (HTC) methods in the 1950s. Details on the early history of DOC measurements are well-described in Sharp 1997.

2.2 Wet Chemical Oxidation (WCO)
Prior to HTC methods, the primary technique for the measurement of dissolved organic carbon was through oxidation via various agents, such as potassium permanganate or potassium chromate. However, these methods were unreliable for several reasons, such as the difficulty in determining whether oxidation was fully completed and the fact that the chloride in seawater competed in oxidation (Duursma, 1961), making them well-suited for freshwater samples but less so for seawater. A breakthrough occurred in 1934, when Krough and Keys developed an oxidation that incorporated a way to precipitate and remove chlorine with thallium sulfate and reduce its interference on carbon measurements. However, the method was tedious and easily affected by atmospheric contamination. Many permutations of oxidation-based techniques were developed that incorporated various oxidizing agents and chloride-scavengers, namely those reported by Kay, 1954; Dazko, 1939,1950; Duursma, 1961; and Plunkett and Rakestraw, 1955. Recent methods development efforts combining UV radiation and persulfate oxidation have further elucidated the contributing factors resulting in incomplete DOC oxidation including interference by chloride ions (Van Zomeren et al. 2021; Yang et al. 2021).

2.3 High Intensity UV Radiation
Organic carbon can also be converted to measurable CO$_2$ via photo-oxidation by UV radiation, sometimes in conjunction with a photosensitizer such as ferric sulfate (Beattie et al., 1961; Armstrong et al., 1966). For this method, a 1200W mercury arc tube in aluminum housing with a fan apparatus is used to irradiate organic compounds within samples stored in silica-fused tubes. This method yielded high recovery when tested with many organic compounds, including pyridine, ethyl alcohol, and glycerol, but was inefficient at measuring nitrogen-containing compounds such as urea, which caused concern for measuring seawater samples. In 1969, P.M. Williams compared the persulfate and UV oxidation methods and reported significant
differences between the two methods (Williams, 1969). Differences were up to 0.17 mg C L$^{-1}$ (~14 µM).

### 2.4 High Temperature Combustion (HTC)

According to Jon Sharp’s 1997 historical overview, the HTC method’s first iteration was the Soviet dry combustion method (Skopintsev et al., 1966) which resulted in higher-than-expected DOC concentrations in comparison to earlier oxidation methods. Often dismissed as a byproduct of contamination, results from Soviet dry combustion were consistent with new HTC methods developed by Sugimura and Suzuki in 1988. When this method was first established, it was also found that DOC concentrations were considerably higher than those reported using previous persulfate oxidation, dry combustion, and photo-oxidation methods but consistent with the Soviet method. Upon subsequent rigorous review of the raw data, Suzuki retracted the conclusions that surface DOC concentrations were 3-5 times higher than observed previously by other methods. Suzuki attributed the anomalously high values to insufficient blank subtraction and incorrect CO$_2$ peak area computation (Sharp 1993). A portion of the higher DOC in the HTC measurements was found to originate from the catalyst material. Methods were derived to account and correct for this contamination and generally referred to as the instrument blank (Benner and Strom, 1993). The method has been continuously developed and refined over several decades by researchers and scientific institutions that use various catalyst types, such as platinum (most common), palladium, and tungsten. This HTC method provides a rapid and reliable means of quantifying dissolved organic carbon in marine samples and is widely used in oceanographic research today. For additional details on previous DOC protocol activities, refer to JGOFS Report No. 19 (1994), Sharp 1997, and Sharp et al. 2002. The detailed chemical process of HTC is outlined in Section 5. This method is sensitive to precise analytical methods, accounting for the instrument blank, and having a well-conditioned catalyst (Sharp et al., 1995). The uncertainty in our current HTC methods is reported as only +/- 1.5 µM (Halewood et al., 2022), highlighting the significant improvements that have been made in the last 60 years.

### 2.5 A Comparison of Analytical Methods

A significant amount of work has been done on intercomparisons between methods of DOC measurement. One important and comprehensive analysis was reported by Sharp et al., 1995,
who worked with 59 analysts to determine the variability of results from measurements of the same two samples using their respective methods. Sharp found that the majority of results from the experiment were within 10% of the expected value but was not satisfied with the precision of such a result. He urged the development of a standardized seawater reference material and blamed the inconsistency on lack of reference materials, unconstrained instrument blanks, and instrument unreliability as the major impediments to accurate measurements throughout the community.

2.6 The Development of the Certified Reference Material (CRM) Program

With the need for standardization of methods across the oceanographic community, the development of a suitable reference material was crucial. The Consensus Reference Material (CRM) program was established in 1999, funded by the U.S. National Science Foundation. The program is run by the Hansell Organic Biogeochemistry Laboratory at the University of Miami Rosenstiel School for Marine, Atmospheric, and Earth Sciences. Material is collected from the Florida Straits at surface, mid, and deep depths to provide analysts across the global access to a standardized seawater reference. The use of reference material is highly recommended and should be considered a requirement for analysis of seawater samples.

Reference material can be obtained here: Consensus Reference Material (CRM) | Hansell Lab (miami.edu)

3 SAMPLE COLLECTION PREPARATION

Samples and supplies are easily contaminated so they must be prepared and handled carefully. Use only unpowdered nitrile gloves throughout the process and minimize handling as much as possible, as skin oils can be major contaminants. Avoid touching door handles and any potentially contaminated surfaces and items while wearing gloves.

3.1 Vials

Borosilicate vials (40 mL) with polypropylene open-top caps with fluoropolymer resin/silicone septa (Teflon or other fluoropolymer liner facing down into the vial) are recommended for
sample collection. If possible, use amber colored vials to mitigate photo-oxidation of organic compounds. New vials should be uncapped and combusted at 450°C for at least 4 hours, and caps must be soak overnight in 10% HCLsolution.

If vials are being reused, soak them in 10% HCl for several hours and follow with a rinse with ultrapure water before combustion. Generously rinse caps in ultrapure water, soak them overnight in water, and rinse generously three times. Air-dry caps beneath a clean hood or briefly in an oven set to 60°C or less. Do not leave caps out uncovered, as dust may settle on them. When vials are cooled, cap vials tightly and return them to their storage box.

Caps are composed of plastic material that contains carbon polymers; therefore, it is not recommended to soak caps in acid except when they are new as plastic may leach into the sample after collection. Do not use caps with Teflon liners that have already been pierced by an analyzer to collect/store samples, as the sample must be stored in air-tight conditions (Halewood et al., 2022).

3.2 Hydrochloric Acid

If possible, prepare an appropriate volume of reagent grade (or higher purity) 4N HCl to be aliquoted to 1 mL glass ampoules. If many stations are to be sampled, prepare one ampoule per station if possible. Seal carefully with flame and pack a scoring file to open them at sea. Do not use open flame near any compressed gas tanks! If this method is not a viable option, prepare acid in a glass vial with Teflon caps stored upright. If practical, avoid using a plastic drop bottle to prevent potential leaching. Aliquot the acid into several vials, even if not filled, to reduce opening and closing of the same vial repeatedly during fieldwork. This will reduce the risk of contamination.

3.3 Filters, Filter Cartridges, and Filter Capsules

Loaded filter cartridges are recommended for in-line sample collection from a peristaltic pump or Niskin bottle. Alternatively, capsule filters can be used, however they require significant flushing volumes to reduce contamination (≥1L; Mannino et al., 2019).
Combust 47 mm GF/F (nominal 0.7 µm pore size) or GF-75 (nominal 0.3 µm pore size) filters at 450°C for a minimum of 6 hours. Filters can be placed within a glass jar and combusted as a group, or preferably, wrapped individually in foil before combustion. It is not recommended to combust filters more than once (i.e. after storage for long periods of time) as it compromises the intended pore size and increases the risk of tearing. Glass fiber filters are recommended as they can be pre-combusted and do not require flushing with large volumes. Plastic disc filters (polyethersulfone, nylon, polycarbonate) may be used with sufficient rinsing with sample water (or ultrapure water followed by sample water; 175 mL for 47 mm disc filters) prior to sample collection. Experiments with these filters and rinse procedure yielded DOC concentrations ranging from 7.9 ±12.0 to 43.3 ±13.3 µg C L⁻¹ except for nitrocellulose (see Table 1 in Mannino et al., 2019).

To Prepare Filter Cartridges:

Connect ~ 6 inches of platinum-cured silicon tubing to each end of the cartridge. We recommend using 47 mm diameter filters and polycarbonate or polypropylene filter holder cartridges for this method. Cartridges, O-rings, and tubing should be rinsed with 10% HCl followed by ample ultrapure water and dried briefly beneath a hood or low-temperature oven. Once dried, wrap the entire cartridge in pre-combusted foil for storage. Do not preload cartridges with filters.

**4 SAMPLE COLLECTION & STORAGE**

For samples collected in oligotrophic offshore and coastal ocean areas, collecting water samples directly from Niskin bottles can minimize contamination. Filtration can be accomplished with inline filters at the Niskin bottle through gravity filtration. In some circumstances, sample collection and filtration from Niskin bottles is not practical, especially for surface waters with high particle loads. In this case, sample water can be filtered under a gentle vacuum (<5 mm Hg; oil-free vacuum pump) or peristaltic pump in a clean laboratory setting. Glass bottles are recommended for water collection because these can be combusted to minimize contamination, but this is not often practical. Plastic bottles or carboys (Teflon, polycarbonate, polypropylene or high-density polyethylene) are often used for samples collected in coastal waters where DOC
exceeds 150 µmol C L⁻¹, as long as the bottles and caps (Teflon-lined or polypropylene) are cleaned with suitable detergent (RBS, Liquinox) and 10% acid, rinsed thoroughly with ultra-pure water, and oven-dried.

There are several options for disc filters depending on the anticipated particle load: glass fiber filters (nominal ~0.7 µm pore size such as Whatman GF/F filters or nominal ~0.3 µm pore size such as Advantec GF-75 filters; pre-combusted in furnace at 450 ºC for 6 hours), 0.2 µm polycarbonate (PC) filters, polyethersulfone (PES) or nylon membrane filters. Glass fiber filters are recommended because they can be rendered carbon-free by combustion in a muffle furnace, but the larger pore size contributes uncertainty between the particulate and dissolved organic carbon. All non-combustible filters such as the PC, PES, and nylon filters can be rendered very low carbon by rinsing with ultrapure water and sample water or copious amounts of sample water (~100 to 150 mL for 47 mm-diameter filters) prior to collection of sample filtrate. Evaluation of contamination from filtration process is strongly encouraged. See IOCCG CDOM protocol for further details on DOC contamination from disc and capsule filters.

4.1 Sampling Preparation
Do not handle any supplies without wearing gloves during preparation or while sampling. Use of only powder-free nitrile gloves is recommended as alternatives such as vinyl gloves can more readily leach OC compounds. Sometimes, the collection of nutrient samples requires the use of vinyl gloves, or no gloves at all, to limit nitrogen contamination (Becker et al., 2020). If nutrient samples are being collected, insist on sampling first if possible and avoid touching the spigot. Change gloves before acidifying samples. Be attentive and avoid touching items and surfaces that can contaminate gloves (i.e. doors, tables, computers). DOC samples can be easily contaminated by oils on the skin and surfaces, as well as organic fumes from chemical such as acetone and methanol, cigarette smoke, ship exhaust, and other aerosols.

4.2 Inline Niskin Sampling
When sampling from Niskin bottles on a CTD, it is recommended that samples be collected directly from the bottle through an inline filter if possible, rather than benchtop filtration of an aliquot. This is especially critical when sampling low DOC concentration (roughly <75 µM)
waters. To prepare the filter cartridge before sampling, rinse the entire apparatus thoroughly (cartridge, O-ring, tubing) with ultrapure water. *If the ship does not provide access to ultrapure water, pack a large bottle to use for rinsing.* Once rinsed, carefully unwrap a single filter and place on the grated side of the cartridge using *clean* forceps. Return the forceps into the foil it was packed in. Place the O-ring on top of the filter and screw the cartridge ends together.

Place the tubing of the filter cartridge onto the spigot of the Niskin. Avoid directly touching the spicket, even with gloves. Remove the valve cap and flush the filter holder for a minimum of 10 seconds. Once flushed, replace the valve cap and allow the water to flow for another 10 seconds before beginning collection. Begin collecting water, avoiding placing the tubing directly into the vial. Rinse the vial with ~5 mL of sample water three times and pay attention to the flow rate of the filter holder; if the flow rate suddenly increases, the filter may have torn and needs to be replaced. Once the vial is adequately rinsed, fill the vial to the top, leaving very little headspace if samples are to be acidified. If samples will be frozen, fill the vial ~3/4 full (below vial shoulder) to allow for water expansion. To minimize contamination, do not overflow sample vials or bottles while filling.

Sampling should occur as soon as possible to avoid collecting water in which particles have settled within the Niskin. Samples should be collected from the deepest to the shallowest depths because concentrations of DOC decrease with depth, therefore sampling from lower concentration to higher concentration lessens potential for contamination. If materials are available, using two separate filter holders for deep versus surface depths is recommended.

Previously, it was common practice to filter only upper ocean samples (<250 meters) and to collect the deeper samples as unfiltered whole water, yet still referring to those samples as DOC instead of total organic carbon (TOC). Though this was a largely adopted practice, significant differences between whole water and filtered water in the bathypelagic beneath productive waters has been reported (Lopez et al., 2020). Though it may be the case that DOC concentrations are equivalent to TOC in waters where particle export is negligible, particle export events can be sudden and episodic (Smith et al., 2017). Unusually high particle flux to the deep ocean in *oligotrophic* waters has been reported as well (Fischer et al., 2016), and locally
elevated DOC concentrations are a common occurrence in the current global DOC database (Hansell et al., 2021). Therefore, collecting unfiltered water risks the incorporation of POC and ultimately skews DOC measurements.

The volume in which vials are filled appears to have an impact on DOC concentration. In a preliminary field experiment, it was determined that samples linearly increase in concentration with increased headspace (Figure 1). For consistency, fill vials to the base of the vial neck and seal tightly before storing to minimize exposure to the atmosphere. However, leave ~25% headspace to allow for expansion if samples are to be stored frozen, otherwise the vials may shatter.

![Figure 1. DOC concentrations [µM] of samples collected in the Florida Straits at ~600 meters. Vials were filled to different levels; completely full (no headspace), with 1/3rd of the vial filled, and with 2/3rd of the vial filled. The regression fit indicates a strong correlation between headspace and DOC concentration ($R^2 = 0.89$) (Custals and Lopez, unpublished data).](image)

4.3 Surface Sampling
Samples from the surface or at shallow depths can be collected using a peristaltic pump. Platinum-cured silicone or Teflon tubing and a battery-powered, rechargeable pump are recommended. A weight should be secured onto the end of the tubing to ensure the tube is fully submerged. A steel fishing weight works well if tied in increments onto the tubing to prevent the weight from falling off. Ensure that the weight rests ~0.1 meter above the end of the tube so the sample water does not make contact with the weight.

A capsule filter or a loaded filter cartridge can be placed on the receiving end of the tube to directly collect samples. However, be sure not to pump the water too quickly, which would put excessive strain on the filter and risk tearing and/or leaching of particles. In previous experiments, 0.2 µm polyethersulfone and Versapor capsule filters flushed with 20L of ultrapure water contributed ~2 to 7 uM C of contamination (Mannino et al., 2019). Therefore, capsule filters are not recommended for collection of DOC from ocean waters unless these can be rinsed with 20 L of ultrapure water or in combination with sample water prior to DOC sample collection (Mannino et al., 2019). Certain capsule filters may be appropriate in high DOC waters after flushing with a minimum of 2L of water.

4.4 Benchtop Filtration

In-line filtration from the Niskin can be time consuming and impede sample collection for other parameters, especially in high POC environments (i.e., coastal waters). If inline filtration is not feasible or if surface samples are being collected over the side of the ship, samples can be filtered on the benchtop using a dome filtration rig. This should be done as soon as possible after the bulk water is collected. Be sure to homogenize the water in the receptacle by gently swirling it, both clockwise and counterclockwise before filtration.

The recommended setup for benchtop filtration is a glass-fritted filtration apparatus inside a dome filtration system, which allows for direct filtration into a clean vial as opposed to collection into a vacuum flask. Either 25 mm or 47 mm filters can be used, but 47 mm is recommended to reduce particle loading. Supplies permitting, it is recommended to use one filter per depth. The apparatus may require the fitting of clean, acid-washed tubing onto the stem of the filtration apparatus to direct the filtrate flow into the vial (Figure 2).
Though the apparatus is fitted with a vacuum flask, gravity filter the samples whenever possible. If time is short and vacuum is needed, use the absolute lowest pressure necessary and oil-free vacuum pump. Be sure to test the vacuum pressure with a pure water sample before beginning sample filtration. *Do not use a vacuum greater than 5 mmHg.* Filtration must be completed before acidification of the sample, since acidifying results in dissolution of particles that will lead to inaccurate DOC measurements.

*Figure 2. Bell filtration apparatus*

### 4.5 Post-Collection Processing

#### 4.5.1 Acidification

After collection, discard filter and rinse the cartridge generously with ultrapure water. Place the holder in a 10% acid bath if possible.

Prepare the bench space by laying a new sheet of foil onto the table and add 50 to 80 μL (2 μL per mL of sample for seawater) of 4N HCl to each vial with a pre-combusted glass Pasteur pipet or similar non-carbon contaminating dispenser option. Freshwater or brackish samples will require less HCl. If acid was prepared in ampoules, draw from only one ampoule per station.
Add acid to samples from the deepest to shallowest depths to limit contamination from splashing. Gently invert the vial several times to mix. Acidify samples as soon as possible, ideally immediately after collection. Seal tightly and store upright.

The recommended volume of acid varies between protocols. It is important for enough acid to be added to the vial to bring the pH below ~3. If you are unsure whether acid was added to a particular vial, it is acceptable to add a second aliquot without compromising the sample. The recommendation for sample receptacle and storage has changed over the years. Previously, samples were collected in polycarbonate bottles and stored frozen (Halewood et al., 2022). Due to concerns of leaching from the bottles and the inability to combust them before use, samples were then collected in pre-combusted 40 mL vials. However, if it can be avoided, the sample should be acidified and not be frozen due to high risk of the vial shattering. Studies from Halewood et al., 2022 indicate no significant difference in DOC concentrations amongst acidified samples stored at room temperature versus frozen, therefore room temperature or refrigerated storage is recommended.

Samples are acidified for two reasons. First, to stop biological activity, and second, to chemically convert inorganic carbon species to CO₂. Because it is a gas, CO₂ can then be expelled naturally from the sample. This, in theory, leaves behind only organic forms of carbon in the water. Most of the inorganic carbon in seawater exists as bicarbonate (HCO₃⁻), as it is the dominant species in the pH range of seawater (Figure 3, gray shaded area). By acidifying the sample and reducing the pH to 2-3 (red shaded area), HCO₃⁻ is completely converted into CO₂ and off-gases.
Historically, DOC samples have been frozen after collection at -4°C. Halewood et al., 2022 determined acidification to be a more consistent and stable option. However, if planning to freeze the samples instead, fill the vial only 75% full to allow for expansion while the water freezes. Handle frozen vials carefully; glass is more likely to crack at low temperatures. Cracking is minimized by storing samples horizontally in plastic bags while freezing (higher surface area to allow for expansion). Wipe the filled vials thoroughly before placing in freezer to avoid them freezing to each other.

4.6 Notes on Sampling at Sea

During fieldwork, it can be difficult to collect samples without exposure to contaminants.

Adverse environmental conditions at sea are unavoidable but can pose a risk for sample contamination. For example, sampling in rainy weather or rough seas could introduce raindrops
or sea spray into samples. If possible, use a bulb apparatus to protect the vial during collection. Also avoid water splashing from those sampling nearby.

Ships in the open ocean eliminate trash using an incinerator. It is possible that fumes and smoke from these processes can contaminate DOC and other types of samples. Similarly, the diesel exhaust is sometimes located near the sampling bay. If there is no way for the crew to redirect it, sample quickly and do not leave vials open longer than necessary.

Storage is often limited in research vessels. If storing in a refrigerator (not necessary if samples are acidified, but recommended), do not store samples in the same location as volatile organics that are often used for other sample types. Glutaraldehyde and paraformaldehyde are commonly used at sea for fixation of biological samples and must be avoided. Acidify samples beneath a fume hood that is not used for the fixation of biological samples as well and wear safety googles and nitrile gloves when handling acid. Multiple layers of protection can minimize potential contamination from organic fumes such as double or even triple sealing vials in zip loc bags and storage in container bins (well-insulated coolers or totes that seal well) and locations with no fumes.

5 HIGH TEMPERATURE CATALYTIC COMBUSTION THEORY

High temperature catalytic combustion is the recommended method for the analysis of DOC concentrations from all saline waters. Though several manufacturers offer instruments that utilize this method, this protocol was developed using Shimadzu TOC-L analyzers as a guide. Though instrument interfaces vary, the process of analysis is typically the same: to convert all the organic carbon into CO$_2$ using a solid-phase catalyst that can be detected by a non-dispersive infrared (NDIR) gas detector.
The internal components of the TOC-L analyzer can appear daunting at first, therefore we present a simplified description of the interior chemical processes for an instrument equipped with a high-salt kit. A visual representation of the components involved in the combustion and subsequent processing is presented in Figure 4. This visual does not include components specific to analysis of IC or for carrier gas flow that these instruments have.

Steps

1. The needle in the autosampler unit pierces the septum of the sample and draws it into the syringe (1). Typically, the volume drawn into the syringe is sufficient to perform many sample injections. A user-specified volume of acid is then added to the syringe along with the sample aliquot. For open-ocean or low DOC samples, 120 uL is sufficient.
volume of 50 uL for high concentration marine or riverine samples is suggested to preserve the life of the catalyst. Though samples are pre-acidified, we recommend the additional acidification step offered by the instrument software to ensure that any remaining inorganic carbon is converted into CO$_2$. The carrier gas then sparges the sample within the injection syringe to thoroughly mix the acid and flush any evolved CO$_2$ gas. The carrier gas must be free of CO$_2$ and hydrocarbons. The TOC system may use a building compressed air source with purification traps and TOC gas generator to remove hydrocarbons or a compressed gas cylinder of sufficient purity (UHP-zero grade or better; 99.9995% air with <0.05 ppm total hydrocarbons).

2. Once sparging is complete, an aliquot is injected into the heated combustion column (2). This step converts DOC into CO$_2$ gas via the following reaction:

$$\text{DOC} + O_2 \rightarrow CO_2 + H_2O$$

However, the combustion of some complex organic compounds does not fully convert to CO$_2$ by heat alone. Incomplete combustion results in the formation of carbon monoxide (CO):

$$\text{DOC} + O_2 \rightarrow CO + H_2O$$

To accurately measure DOC, any carbon monoxide that is produced must be converted into CO$_2$. This is accomplished by utilizing platinum catalyst that is loaded into the combustion column. The catalyst converts CO into CO$_2$ by efficiently binding both CO and O$_2$ onto its surface, encouraging the reaction between the two species by bringing them into proximity.

$$CO + O_2 + \text{Platinum} \rightarrow CO_2$$

3. After combustion, the resultant gas mixture is passed through a cooling coil (3) to condense the water vapor.
4. A water trap (4) collects the condensed water and the gas is passed through a backflow chamber (5) to prevent potential backflow of the acid chamber (6). As a side note, the water in the water trap is an excellent source of carbon-free water to determine the instrument blank. Depending on the instrument model and with some minor plumbing adjustments, the water in this trap can be directed into a sample port on the syringe for direct injection into the combustion tube. On the TOC-L model, this is best accomplished by attaching a waterline into the third opening on the water trap (if not already attached), then attaching it to port 1 of the 8-way valve. Run a water blank as usual, but now the instrument will draw from the water trap rather than the reservoir. Be sure that the water trap has sufficient water and that the ports are returned to the original configuration when complete. The measurements should be similar to blank measurements from the reservoir.

5. The gaseous sample is then passed through the acid chamber. This chamber is a key component for the analysis of inorganic carbon, which TOC-L analyzers are capable of accomplishing. However, this chamber serves no substantial chemical purpose for DOC analysis, but it is useful to ensure that bubbles are being produced in the chamber and carrier gas is flowing. Otherwise, there may be a leak in the system.

6. The sample is then passed into an internal dehumidifier (7) to remove any remaining water vapor. In the TOC-L and TOC-V, the dehumidifier is hidden in the rear of the instrument.

7. In non-aqueous conditions and elevated temperatures, HCl can exist as a gas. HCl can be produced throughout the analysis process and can react with oxygen to produce chlorine gas.

\[
\text{HCl} + \text{O}_2 \rightarrow \text{Cl}_2 + \text{H}_2\text{O}
\]

These gases are extremely corrosive and will damage the NDIR detector, so the sample is passed through a halogen scrubber (8).
The halogen scrubber is a tube filled with copper metal filaments. Chlorine gas reacts with solid copper, resulting in cupric chloride which adheres to the metal surface and prevents any gas from reaching the detector, subsequently turning the metal filaments brown.

$$\text{Copper} + \text{Cl}_2 \rightarrow \text{CuCl}_2$$

It is recommended to change the halogen scrubber when the copper begins noticeably changing color at the inlet. The scrubber is vital for the health of the instrument and integrity of the NDIR, so it should be checked and changed regularly. Change the scrubber at any sign of color change.

8. The sample gas then passes through a mist catcher, collecting any remaining vapor (9).

9. A membrane filter (10) catches any particulates that may have carried through the system (salt, ash, etc.).

10. The fully purified CO$_2$ then passes through the NDIR (11) where it is analyzed.

11. Once passed through the NDIR, CO$_2$ is collected by the CO$_2$ absorber to prevent carbon emission into the atmosphere (12).

### 6 PREPARING STANDARDS

Standard solutions of a known carbon concentration must be prepared to calibrate the instrument prior to sample analysis. American Chemical Society (ACS) grade potassium hydrogen phthalate (KHP) is recommended, but other carbon-containing standards of high-purity such as sucrose or glucose are acceptable. These other compounds could also be used as an evaluation standard. The shelf life of these standards is quite low, especially for glucose and sucrose. New standards should be prepared weekly.
The TOC instrument can create calibration curves based on two methods: the measurement of discrete standard solutions prepared manually, or the automatic dilution of a stock solution. Regardless of the method chosen, a new calibration curve for each run is essential. This allows the analyst to use a calibration curve that is specific to the individual run, rather than relying on past performance.

6.1 Manual Stock Dilutions

6.1.1 Preparation of Stock Solution

The concentration of standards to be prepared is dependent on the expected range of DOC concentrations in the sample set. For open ocean and low DOC samples, a five-point calibration curve using 0, 25, 50, 75, and 100 µM C\(^{-1}\) of KHP is recommended (Halewood et al., 2022). These concentrations are obtained by preparing a high-concentration stock solution and diluting accordingly. This method has been adapted from Halewood et al., 2022; please see reference for more detail. For samples with a broad DOC range, it would be advantageous to prepare both a low and a high standard calibration curve (e.g., 30-150 and 50-400 µmol C L\(^{-1}\)). The authors of Halewood et al. recommend a standard stock concentration of 10 mmol C L\(^{-1}\) for preparing standards. This would require 0.2553 g of KHP per liter of stock solution. The calculation for this is as follows:

\[
\frac{10 \text{ mmol C}}{1 \text{ L}} \times \frac{1 \text{ mol}}{1000 \text{ mmol}} \times \frac{1 \text{ mol KHP}}{8 \text{ mol C}} \times \frac{204.22 \text{ g}}{1 \text{ mol KHP}} = 0.2553 \text{ g KHP}
\]

This calculation format can be followed if a different concentration of stock solution is desired. Note that the concentration is in units of mmol of carbon, NOT mmol of KHP. There are 8 moles of carbon in each mole of KHP.

Rather than using volumetric flasks to prepare standards, weighing using a balance is recommended (Halewood et al., 2023) if the analyst is confident in their analytical skills and the balances are properly calibrated annually and verified regularly. Weight is an accurate measure of volume because the density of pure water is 1 g mL\(^{-1}\). Volumetric flasks can warp over time and are subjective to the analyst’s eye. Volumetric glassware also poses a higher risk of
contamination because they should never be combusted due to the potential for high heat to warp the glass, but if properly cleaned with detergents (Liquinox followed by RBS-35 or only RBS-35) followed by acid bath soak and copious rinsing with low TOC ultrapure water), flasks provide a suitable alternative.

To prepare standards:

1. Weigh the calculated amount of KHP using a microbalance. Record the weight. This does not need to be exact; you will calculate the actual concentration when finished.
2. Tare an acid washed, pre-combusted glass bottle. This container should have a tightly fitted Teflon-lined cap, as this solution will be stored and reused.
3. Add the KHP to bottle.
4. Carefully add ultrapure water until target volume is reached. Record final weight. Again, this does not need to be exact.

The final concentration of the stock solution, if preparing a 10 mmol C L$^{-1}$ solution, can be corrected for using the following equation:

$$\frac{\text{Weight KHP (mg)}}{\text{Volume (final weight, mL)}} \times 39.1696$$

Store the stock solution in a refrigerator. Allow the solution to attain room temperature prior to diluting.

Use ultrapure (Type I; resistivity $\geq 18.2$ M$\Omega$ cm) and ultraviolet oxidized water (e.g., Milli-Q Gradient, etc.) with total organic carbon $\leq 5$ $\mu$g C L$^{-1}$ for preparation of all solutions (acids, calibration standards), filling all containers used in the TOC analyzer, and final rinsing of cleaned glassware and other materials. Water purification systems require diligent system maintenance to ensure high quality laboratory water with low DOC. A well-maintained water system can yield TOC peak area responses equivalent to that of instrument blanks. Several manufacturers equip ultrapure water systems with TOC monitors that provide an indication of the carbon content of the water.
6.1.2 Dilution of the Stock Solution

If a 10 mmol C L\(^{-1}\) stock was prepared, the following equation can be used to calculate the dilution volumes.

\[
stock\ dilution\ volume\ (mL) = \frac{final\ volume\ (mL) \times desired\ concentration\ (\mu M\ C)}{1 \times 10^4}
\]

For example, a desired solution of 500 mL of 100 µM C would be prepared by diluting 5 mL of 10 mmol C L\(^{-1}\) KHP stock to 500 mL total volume. Use the same weighing method as described above.

To correct the final concentration based upon actual weights, use the following equation:

\[
\frac{1000 \times stock\ concentration\ (mM) \times stock\ weight\ (g)}{final\ weight\ (g)} = standard\ concentration\ (\mu M\ C)
\]

For coastal and high-concentration DOC samples, the range of calibration concentrations should be selected case-by-case rather than confining standards to 0 – 100 µM. In that case, it is useful to create a calibration curve with more than 5 points or create a second calibration curve. If measuring a set of samples that vary significantly in concentration, we suggest running high and low DOC samples separately, reconditioning and/or replacing the catalyst between analyses, and running appropriate calibration curves for each set rather than using only one general curve. However, the range of concentrations in a sample set can be unpredictable in highly variable environments. In this case, either expand the calibration concentrations or utilize the Shimadzu’s software capabilities to create two curves. The software provides a feature in which the closest fitting calibration curve is selected to calculate sample concentrations, but no more than five points can be selected for a single curve. However, it is recommended that the final concentrations be reviewed and calculated manually. Reviewing measurements from all injection scans is recommended, including ones that were excluded from the calculation by the software. This provides insight into the precision of each measurement and any potential carry-over from the previous sample (i.e. if the first injections of a sample are anomalously high immediately
after a high-carbon sample, you would want to ensure those injections are excluded). This process is further discussed in Section 9: Data Processing.

6.2 Automatic Stock Dilutions

The use of the auto-dilution feature on the Shimadzu instrument requires only the preparation of a stock solution, as described in Section 6.1.1 above. Instructions on programming the instrument to auto-dilute the stock solution are provided in Section 8.3.2.

6.3 Reference Material

The use of seawater reference material is essential to ensure accuracy. References are available from the Rosenstiel School Hansell Organic Biogeochemistry Laboratory CRM program in three concentrations: ~42, ~60, and ~80 µM C. For the best results, utilize all three. Note that the high DOC reference can be more variable than the lower concentration DSRs.

7 PREPARING FOR INSTRUMENT MEASUREMENT

7.1 Removing the Column from the Instrument

Before proceeding, ensure the instrument is shut down completely and the column has cooled. If the instrument is running, select “Shutdown”. The fan will continue running for 30 minutes. Leaving the fan running is vital because it cools the injection block that holds the quartz column. If this procedure is not followed, the injection block can warp and/or melt, causing the instrument to leak.

Once the column is completely cooled, open the hood and remove the posterior bolt (1), then loosen the two bolts on the steel frame (2) (Figure 5). Carefully remove the injection block (3) by sliding it forward. Wipe any visible salt off the injection block using ultrapure water and a Kimwipe. Unscrew the plastic bolt on the righthand side (4), which is the connection to the carrier gas.
Hold the bottom of the combustion tube and unscrew the plastic nuts connecting it on the bottom, which may require the careful use of a wrench. Continue holding the column underneath while pulling the entire injection block apparatus upwards. Separate the apparatus from the top of the column and set aside. Notice where the drain tube is inserted and remember to place it properly back into the drain when reinstalling the column. Otherwise, water will drain into the internals of the instrument.

7.2 Preparing the Column

The combustion column needs to be prepared and replaced before turning on the instrument.

1. Obtain a new quartz column. Columns may be reused if in good condition, i.e., no substantial salt accumulation, which increases the risk for the glass to crack and/or shatter when reheated. Rinse the column thoroughly with ultrapure water and dry completely under a clean hood or in a low-temperature oven. Proper rinsing can extend the lifetime of the quartz column.

2. When the column is dry, place the white ceramic plug into the wide end of the column. Ensure that the plug lays flat. Use the metal stomper to gently pack a small amount of
quartz wool on top of the plug. Be careful not to inhale any wool as you break pieces apart; it is a dangerous carcinogen and can damage your cilia (small hairs that line the bronchial tubes and help move mucus and dust out of the lungs). Quartz wool should only be handled underneath a fume hood.

3. Add the large platinum catalyst spheres 2-3 cm above the wool. Add the smaller catalyst spheres on top until they reach 14 cm from the top of the column (Halewood et al., 2022).
   a. If using new catalyst, soak the amount of catalyst to be used in 20% HCl for 3 hours then rinse thoroughly. Dry the catalyst in a combustion oven for ~30 minutes, or until completely dry.
   b. Though the catalyst can last up to 10 weeks running while samples full time (~1,400 samples), salt that accumulates between the spheres should be removed regularly. If you are running the instrument full time, it is recommended to do this once a week (after ~250 samples). To do so, allow the instrument to cool completely and carefully remove the column, as outlines in Section 7.1. Pour the catalyst into a clean beaker and separate the large spheres from the small ones. You will notice a buildup of salt which can be removed by straining the small spheres. Using clean forceps, discard as many cracked spheres as possible and replenish with fresh catalyst if needed.

4. We recommend using platinum mesh to cover the top of the catalyst spheres. The mesh can either be purchased as sheets or in circle cut-outs. If using a sheet, cut a 2 x 2 cm piece and crumple it into a loose sphere. Prepare several spheres and place them in an even layer on top of the small platinum spheres in the column. This provides “cushion” for the sample when it is injected, preventing it from splashing. Splashing during injection can cause asymmetrical integration peaks and reduce accuracy.

5. Very lightly grease on the upper and lower outer ends of the column. Do not allow any grease inside the tube. Only a very tiny amount of silicone grease should be used to ensure a gas-tight seal on both ends of the combustion column where the O-ring (top) or fittings (bottom) seal against the combustion tube.
6. Reinstall the column. *Do not forget to reattach the drain tube to the drain* (Figure 6).

![Image](image.jpg)

*Figure 6. Shimadzu drain tube*

### 8 INSTRUMENT OPERATION

Here, we outline steps to prepare the instrument, run the analysis, and navigate the Shimadzu software. For detailed information, consult the Shimadzu User Manual. Though this is specific to the Shimadzu TOC-L model, the fundamental steps are similar for other instrumentation (Elementar analyzers, etc.).

#### 8.1 Water and Reagent Reservoirs

There are 5 reservoirs that need to be checked before running the instrument. Only use ultrapure water. We recommended replacing the water in the blank and auto-dilution containers daily, even if not depleted.

1. The blank ultrapure water container
2. The internal water humidifier
3. The HCl and H₃PO₄ containers. These should be diluted to 25%.
4. The water reservoir for the autosampler, if applicable

**8.2 Warming Up the Instrument**

Once the column has been reinstalled and reservoirs are replenished, turn on the machine with the external switch. Open the valve on the carrier gas tank or turn on the air generator system. Open the Shimadzu software and select ‘New’ to create a new sample table. Save the file, then select “Connect” (Figure 7). The instrument will begin an initializing procedure. Once the instrument connects, open the “Monitor” tab and increase the magnification to 50x. Wait until the parameters read “OK” and the baseline plot does not fluctuate. Allow the instrument to warm up for ~1 hour before use, even if the parameters read “OK”.

When reservoirs are replenished it is good practice to flush the flowlines and perform a wash of the autosampler reservoir. These actions can be found under “Maintenance”. A zero-point detection should also be completed, which allows the instrument to recalibrate the needle motor to inject an accurate amount of sample during operation. Check the syringe regularly for any leaks. Replace the syringe plunger tip when necessary.
8.3 Creating a Calibration Curve

A calibration curve file needs to be created before running samples. We recommend processing the final data offline and the concentrations calculated by the instrument from these calibration files will not be reported. However, using a calibration curve file allows you to monitor the approximate concentrations of samples during sample measurements and identify when the instrument is not running properly. However, we do recommend running a new calibration every few weeks and when using new catalyst to monitor the performance of the instrument.

There are two ways to create a calibration curve; manual preparation of four concentrations of standard solution (See Section 5) or setting the instrument to auto dilute a stock solution.

8.3.1 Calibration Curve from Manual Standard Preparation

To create a new calibration curve file, select ‘File’ → ‘New’ → ‘Calibration Curve’ (Figure 8,9).
Uncheck ‘Use dilution from standard solution’.

**Calibration Curve Wizard Page 3**

**Analysis:** Select ‘NPOC’. If you are measuring TN as well, as separate calibration curve file will need to be created.
Default Sample Name/ID: Any samples populated in the sample table will be initially labeled by this parameter. The name and ID can be changed when populating the sample table, so this can be left untitled.

Calculation Method

Zero Shift: This determined whether your “0” standard solution will be shifted to zero in the final calibration curve. Since ultrapure water is used for this and will not measure as 0 µM when analyzed, check this box.

Multiple Injections: This allows multiple injections of sample from the same aliquot pulled into the syringe to be used. Check this box.

File Name: Set your calibration file name. Include the date and standard (KHP), and concentration max. For example: ‘20220311_KHP_100uM.cal

Calibration Curve Wizard Page 4

Units: Selecting the “no unit” parameter allows you to create a calibration curve based on the unit you define in the calibration points list (see below). We report DOC in µM, which is not an option in the software, so we recommend using the ‘no unit’ setting.

No. of Injections: This defines the number of injections that will occur and be included in the concentration calculation. We recommend 3 of 7, which means that concentrations from the best 3 injections will be factored into the calculation. The remaining 4 will be excluded. The instrument will discontinue measurement if the measurements from the earlier injections are within the statistical boundaries set below.

No. of Washes: This determines the number of times the syringe is rinsed between samples. We recommend 1 wash as a minimum, unless samples are high in concentration (>300 uM) at which 3 washes are recommended, especially if samples have highly variable concentrations.

SD Max: This defines the preferred maximum standard deviation that is tolerated. The instrument will continue injections if this requirement is not met, but only to a maximum of 7 injections as set above. The default setting is 0.1, but we recommend 0.05.

CV Max: The preferred coefficient of variation.

Sparge Gas Flow: 80 mL/min
**Sparge Time:** This defines the length of time the needle is purged with carrier gas. Minimum of 1 minute.

**Acid Addition:** Though samples are acidified post-collection, the instrument acidifies before measurement to ensure full removal of inorganic carbon. Addition of 1.5% acid is recommended. Ensure that the acid reservoir is filled and the tubing reaches far enough into the bottle. If you are obtaining extremely high DOC concentrations, it is likely that the tubing is not reaching far enough and the samples are not being acidified properly.

**Autosampler needle washes:** Set the autosampler needle washes to 2 or 3 washes. For high concentration samples or samples with low and high DOC, 3 needle washes are recommended.

**Flow line washes:** Set the flow line washes to 2 or 3. For high concentration samples or samples with low and high DOC, we recommend 3 flow line washes.

**Calibration Curve Wizard Page 5**

You will manually define the concentrations of the prepared standard solutions in this window (Figure 10). Highlight calibration point 1 and select ‘add’. The first calibration point will be the ultrapure water blank, which should be placed into the sample tray as a sample, rather than set to pull from the blank water reservoir. Adjust the number of injections and the SD max as necessary.
Repeat this process for the remaining solutions. Enter the concentrations of the actual concentrations of the standards that were prepared, rather than the target concentrations. Note that the software may revert the ‘Inj. Volume’ parameter to 50 µL every time a sample is added. Be sure to set this back to desired volume when all the standards have been entered. We recommend 120 µL for all samples, except river/marsh/lake samples with high DOC concentrations which could be set to 50 µL to preserve the life of the column (Figure 11).

Save the calibration file. You will come back to it when defining your samples for a run.

8.3.2 Calibration Curve from Automatic Standard Preparation

Programming the instrument to use the auto dilute feature is similar to manual dilutions, however you will keep the option ‘Use dilution from standard solution’ in the calibration wizard window checked. When the ‘Calibration Points’ window appears, you will see a ‘Standard Concentration’ field appear when entering individual concentrations where you will enter your stock solution concentration. There will be a field to enter the desired concentration, where you will enter each
desired concentration for your calibration curve. Remember to set the injection volume back to the desired injection volume when done defining calibration points.

8.4 Creating a Method
Creating a personalized method saves your desired measurement settings into a single method file that you can select later, rather than entering settings every time a sample is added. This is recommended to ensure that future analysis is consistently measured with the same parameters. You can create the method file that mirrors your calibration file settings from the previous section (Figure 12).

Select ‘New’ → ‘Method’

![Figure 12. Screenshot for defining method](image)

Select ‘Use parameters from calibration file’ and select the file created in the last section. The parameter will auto-populate. You can then save this file to refer to later.

8.5 Conditioning the Instrument
When the instrument is ready, run samples of ultrapure water until the area counts of the integration peak stabilize. To do this, select ‘Insert’ → ‘Sample’ (Figure 13). You can also select ‘Multiple Samples’ if you choose. Otherwise, you can copy/paste on the sample table later.

![Figure 13. Location of ‘Insert Sample’ in the software](image)

You will then be brought to the Sample Wizard screen (Figure 14). Here you can select your previously defined method. You can also select ‘Calibration Curve’ if you want to use the exact settings from the curve you defined (recommended). On “Page 2”, be sure to change the analysis to ‘NPOC/TN’ if running both measurements concurrently. NPOC stands for “non-purgeable organic carbon”.

![Figure 14. Selecting previously defined method](image)
You can then copy and paste this sample to add more determinations (Figure 15). When ready to run, select ‘Start’, then ‘Continue running instrument upon sample completion’. You will then be asked to select the vial number. For this, enter ‘0’ for each sample. Setting a vial to 0 instructs the instrument to sample water from the blank ultrapure water reservoir rather than the carousel.

Run samples of MQ until the area counts stabilize. This baseline number will differ between instruments, but area around 1 or 2 is ideal.

To check the integration area counts, select the chart icon in the upper right-hand side of the sample table (red box, Figure 16).
Zoom in on the area plot. Check that the curve is symmetrical. See if the baseline is stable and reaches zero before and after the integration peak. If the peak trails, run water blanks until the system is flushed. It may take many hours, or even a whole day, of running blanks before the system stabilizes.

8.6 Example Data Input
Figure 17. Example sample table

Recommendations for establishing an analytical sequence (See Figure 17):

- Always begin and end a sample batch with 3 or more ultrapure water blanks.
- Include a KHP carbon (or other carbon) standard at the beginning and end of a sample batch and between every 6 to 8 seawater samples. Standards with carbon content in the mid-range of the calibration curve are ideal for this. For a typical set of open ocean samples, ~50 uM is a good option. Check standards are used to confirm that the instrument response is consistent throughout the analysis sequence. The measured concentration of the check standards should be within ±3% of the actual concentration.
- Seawater CRM(s) should be analyzed as a sample every 5 samples. Run blanks before and after the CRM(s).
- Include ultrapure water blanks between every 5 seawater samples.
- Calibration curves should be conducted daily.
- A ‘seawater shot’ should be run before analyzing seawater samples. This primes the column.

**Entering the calibration into the sample table**

The process for defining a calibration curve in the software is different than defining typical samples. Select ‘Insert’ → ‘Calibration Curve’. This enters your defined calibration method into the sample table. If you are using a manual calibration, the software will ask you to enter the vial position for each standard. If you selected an auto dilution calibration, the software will only ask for the vial of the stock standard. You should check the values of the calibration BEFORE running samples. You can do this by selecting the graph option in the sample window (red box, Figure 18), then selecting the ‘Graph’ tab. From there, you can check the R² value and the plot of calibration points. The calibration fit must be ≥0.999.

![Figure 18. Locating the calibration graph](image)

**9 DATA PROCESSING**
Though analyzers can determine final values based on inputs of standard concentrations, it is recommended to use the raw area counts to calculate final concentrations. Sometimes, the analyzer will exclude values that should be included and does not account for blank averages throughout the run which can skew the results. It is useful for the analyst to review the data in more depth to check for errors and adjust as needed.

The instrument reports area counts (i.e. space under the measurement curve) to determine carbon content. To do so, the area counts must be calibrated to standard concentrations (calibration curve/regression), which can then be used in conjunction with the average water blank concentration to determine the true dissolved organic carbon content of the samples.

First, the average area counts of the standards should be determined and used to create a linear regression. The regression fit should be >0.999. If not, the standards need to be prepared again. Shown is a 5-point regression for a sample set in the range of 0 – 300 µM. If the samples to be analyzed have a higher range of concentrations, more standards should be used.

\[
y = 0.1354x + 0.6185 \\
R^2 = 0.9994
\]

*Figure 19. Example calibration curve*
1. Create a regression curve from the standards (Figure 19).
   a. Plot the true concentration of the standards vs. the area counts.
   b. Determine the slope and fit.
   c. Check that the fit of the regression is $\geq 0.998$.
      i. If the fit is unacceptable, the standards will need to be reprepared and the instrument checked for proper performance.

2. Determine the average blank value
   a. Average the area counts for each individual blank.
   b. Determine the carbon concentrations by dividing the average area count by the calibration slope.
   c. Determine the total average blank concentration by averaging all blanks.
   d. Important: the accuracy of this measurement blank should be checked periodically by analyzing the carbon content of the purified water that accumulates in the water trap. To do so:
      i. Inject sufficient ultra-pure water blanks to nearly fill the ultra-pure water trap on the Shimadzu instrument and connect the tubing from this water trap (port 8) to the injection sample port (port 1 which corresponds to vial zero) to analyze the carbon content of the purified water. Use the measurement from this analysis as the instrument blank or use it to verify the value of the instrument blank from the laboratory ultra-pure water injections.
      ii. When the peak areas for the blanks drift significantly during the same run (e.g., $>25\%$), the blank area applied to estimate sample DOC should be linearly interpolated for those samples. However, sharp increases in the blank peak areas (e.g., doubling compared to daily mean peak area) may result from excessive salt build up and degradation of the catalyst beads within the combustion tube. At this point, the combustion tube/catalyst assembly should be replaced.

3. Calculate the final concentration of samples and references by dividing the average area count for each sample by the slope from the regression, then subtracting the average blank concentration.
4. Calculate averages and standard deviations.
5. Check the values of the references against the standardized values. The DOC value for the seawater CRM should be within ±5% and ideally within ±2% of the consensus value.

Total dissolved nitrogen (TDN) can also be measured simultaneously with TOC instruments interfaced with a TNM module by following the same procedure as DOC analysis. Potassium nitrate (KNO$_3$) is the manufacturer-recommended standard to quantify nitrogen content. The instrument precision in the TDN measurement is ideally ≤3% with a %CV of duplicate or triplicate analyses of ±5-10%. Dissolved organic nitrogen content can be estimated as the difference between TDN and the sum of the inorganic nitrogen components of seawater (nitrate, nitrite and ammonium).

10 REPORTING

The following information should be reported:

- DOC concentration of each sample with an estimated relative uncertainty.
- Average DOC concentration and standard deviation of the CRM.
- Average and standard deviation of DOC concentration for ultrapure water blanks and instrument blanks.
- Range and average %CV of replicate sample analysis.
- Bincount: the number of replicate samples

10.1 Uncertainties

Absolute uncertainties for DOC cannot be determined when quantifying a complex mixture of compounds because of differences in catalytic combustion oxidative responses of carbon calibration standards (KHP or glucose) compared to natural seawater samples. Diligent analysis of the CRM provides a way to constrain the relative uncertainty of DOC measurements. However, the CRM is not necessarily representative of the chemical composition of DOC found in coastal regions, where terrestrial organic matter may contribute significant amounts of carbon to DOC, or within a phytoplankton bloom where higher protein and lipid content may be present.
10.2 A Note on Units

The units of DOC are often reported as either $\mu$mol L$^{-1}$ (µM) or $\mu$mol kg$^{-1}$; µM is preferred. To convert from µM to µmol kg$^{-1}$, you must know the density of the water from which DOC was sampled. This can be found within metadata bottle files or can be calculated from temperature and pressure.

The following equation can be used for the conversion:

$$\frac{\mu M}{\rho}$$

Where $\rho$ is density in units of g/mL.
11 REFERENCES


ACKNOWLEDGEMENTS

Thank you to Blake Clark for providing discussion of background of satellite DOC modeling.